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概要

本書では、JBoss EAP 6 を使い始めるための基本的なステップを解説しています。
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第1章 はじめに

1.1. RED HAT JBOSS ENTERPRISE APPLICATION PLATFORM 6

Red Hat JBoss Enterprise Application Platform 6 (JBoss EAP 6) は、オープン標準に構築されたミドル
ウェアプラットフォームで、Java Enterprise Edition 6 仕様に準拠します。これは、JBoss Application
Server 7 を高可用性クラスターリング、メッセージング、分散キャッシング、およびその他のテクノロ
ジーと統合します。

JBoss EAP 6 には、必要な場合にだけサービスを有効にできる新しいモジュール構造が含まれます
(サービスの起動時間が短縮されます)。

管理コンソールと管理コマンドラインインターフェースにより、XML 設定ファイルの編集が不必要に
なり、タスクをスクリプト化および自動化する機能が追加されました。

また、JBoss EAP 6 には、セキュアでスケーラブルな Java EE アプリケーションの迅速な開発を可能に
する API と開発フレームワークが含まれます。

バグの報告

1.2. RED HAT カスタマーポータル

Red Hat カスタマーポータルは、Red Hat のナレッジリソースやサブスクリプションリソースを管理す
る集中プラットフォームです。Red Hat カスタマーポータル  では、以下を行うことができます。

Red Hat エンタイトルメントやサポート契約の管理および維持。

正式サポートされたソフトウェアのダウンロード。

製品ドキュメントや Red Hat ナレッジベースの利用。

グローバルサポートサービスへの連絡。

Red Hat 製品のバグの登録。

カスタマーポータルはこちらからご利用いただけます。https://access.redhat.com。

バグの報告

1.3. RED HAT JBOSS DEVELOPER PROGRAM について

『Red Hat JBoss Developer Program』 (プログラム) を使用すると、開発目的で特定の Red Hat サブス
クリプションを無料でデプロイできます。このプログラムで提供される Red Hat サブスクリプションは
サポートされておらず、既知のセキュリティーの脆弱性に対処していない可能性があります。これらは
開発目的でのみ使用でき、実稼働環境での使用や、アクティブな Red Hat サブスクリプションなしで更
新にアクセスするなどの他の目的を目的としたものではありません。Red Hat JBoss Developer
Program の詳細は、http://www.jboss.org/developer-program/termsandconditions を参照してくださ
い。。

バグの報告

1.4. FULL RED HAT JBOSS COMMERCIAL PROGRAM について

『Full Red Hat JBoss Commercial Program』 を使用すると、実稼働環境にデプロイできます。ソフト
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ウェアの更新とパッチ、サポートサービス、および Red Hat ナレッジベースへのアクセスに対する追加
のエンタイトルメントを提供します。プログラムに参加するには、カスタマーポータル
(https://access.redhat.com/) でアカウントを作成する必要があります。このプログラムの詳細
は、「Red Hat カスタマーポータル」  を参照してください。。

バグの報告

1.5. 詳細情報を見つける方法

このガイドの目的は、Red Hat JBoss Enterprise Application Platform をできるだけ早く使用できるよう
にすることです。詳細は、JBoss EAP の完全なドキュメントスイートをカスタマーポータル
(https://access.redhat.com/documentation/ja-jp/red_hat_jboss_enterprise_application_platform/?
version=6.4) でご利用いただけます。

バグの報告
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第2章 前提条件

2.1. JBOSS EAP 6 のインストールの前提条件

概要

JBoss EAP は、『Red Hat JBoss Developer Program』 または 『Full Red Hat JBoss Commercial
Program』 で利用できます。『Red Hat JBoss Developer Program』 の詳細は、「Red Hat JBoss
Developer Program について」 を参照してください。『Full Red Hat JBoss Commercial Program』 の
詳細は、「Full Red Hat JBoss Commercial Program について」  を参照してください。次の手順では、
両方のプログラムの前提条件について説明します。

一般的な要件

サポートされている設定を確認し、システムがサポートされていることを確認しま
す。https://access.redhat.com/articles/111663。

Red Hat カスタマーポータルでアカウントを設定し、『Full Red Hat JBoss Commercial
Program』 に参加している場合は、システムが RedHat 発行の更新とエラータで最新であるこ
とを確認してください。

ZIP またはインストーラーの要件

インストールディレクトリーの管理者権限を付与する必要があります。

選択した Java development kit が展開 (またはインストール) されていることを確認します。こ
れを行う方法については、Java development kit のドキュメントを参照してください。

Microsoft Windows Server では、JAVA_HOME および PATH 環境変数が設定されている必要が
あります。設定されていないと、ショートカットが動作しません。

Hewlett-Packard HP-UX で、unzip ユーティリティーがインストールされていることを確認し
ます。

バグの報告
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第3章 製品をダウンロードしてインストールする

3.1. JBOSS EAP のインストールの概要

このガイドでは、JBoss EAP の使用をできるだけ早く開始するための最も簡単なインストールプロセス
について説明します。完全なインストール手順は、JBoss EAP の 『Installation Guide』 に記載されて
います。JBoss EAP をインストールした後、Management CLI または Management Console を使用し
てサーバーを設定できます。JBoss EAP を設定する方法は、JBoss EAP の 『Administration and
Configuration Guide』 を参照してください。両方のガイドは、カスタマーポータルの
https://access.redhat.com/documentation/ja-jp/red_hat_jboss_enterprise_application_platform/?
version=6.4 にあります。

JBoss EAP は、次のいずれかの方法でインストールできます。

グラフィカルなインストールプログラムを使用して JBoss EAP をインストールできます。

ZIP ファイルを使用して JBoss EAP をインストールできます。

ご希望のインストール方法に基づいた指示に従ってください。

バグの報告

3.2. グラフィカルなインストールプログラムを使用した JBOSS EAP のダ
ウンロードとインストール

3.2.1. JBoss EAP 6 インストールプログラムをダウンロードする

概要

JBoss EAP は、『Red Hat JBoss Developer Program』 または 『Full Red Hat JBoss Commercial
Program』 で利用できます。選択したプログラムに一致する以下の手順に従ってください。

手順3.1 Full Red Hat JBoss Commercial Program の下でカスタマーポータルから JBossEAP インス
トールプログラムをダウンロードする

Full Red Hat JBoss Commercial Program に参加している場合は、この手順に従ってください。このプ
ログラムの詳細は、「Full Red Hat JBoss Commercial Program について」  を参照してください。

1. ブラウザーを開き、https://access.redhat.com のカスタマーポータルにログインします。

2. Downloads をクリックします。

3. Product Downloads リストの Red Hat JBoss Enterprise Application Platform をクリックし
ます。

4. Version ドロップダウンメニューから正しい JBoss EAP バージョンを選択します。

5. リストから Red Hat JBoss Enterprise Application Platform 6.x.x インストーラー を見つ
け、Download オプションをクリックします。

6. JAR ファイルを選択したディレクトリーに保存するように求められます。ディレクトリーを選
択してファイルを保存します。

手順3.2 Red Hat JBoss Developer Program の下で jboss.org から JBoss EAP インストールプログラム
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手順3.2 Red Hat JBoss Developer Program の下で jboss.org から JBoss EAP インストールプログラム
をダウンロードします

Red Hat JBoss Developer Program に参加している場合は、この手順に従ってください。このプログラ
ムの詳細は、「Red Hat JBoss Developer Program について」  を参照してください。

1. ブラウザーを開き、次の URL にアクセスします。http://www.jboss.org/products/eap。

製品の現在の GA 出荷バージョンのインストールプログラムをダウンロードするには、
ページの右側にある Download ボタンをクリックします。

次の手順に従って、最新のアルファ版またはベータ版のリリース、および製品の以前の
バージョンを含む代替バージョンを選択してください。

a. ページの左側にある Download JBoss EAP リンクをクリックします。

b. 正しい製品バージョンについては、Download 列の下にある Installer リンクをクリッ
クしてください。

2. JAR ファイルを選択したディレクトリーに保存するように求められます。ディレクトリーを選
択してファイルを保存します。

結果

JBoss EAP 6 インストールプログラムの JAR ファイルがターゲットマシンに正常にダウンロードされ
ました。

バグの報告

3.2.2. JBoss EAP インストールプログラムを実行します

JBoss EAP インストールプログラムは、グラフィカルモードまたはテキストモードで実行できます。こ
のトピックでは、インストールプログラムをグラフィカルモードで実行するコマンドについて説明しま
す。

オプションがわからない場合は、デフォルトを使用してください。後でサーバーを簡単に設定できま
す。JBoss EAP サーバーの設定方法の詳細については、カスタマーポータルにある Red Hat JBoss
Enterprise Application Platform 6 の 『Administration and Configuration Guide』 を参照してくださ
い。https://access.redhat.com/documentation/ja-jp/red_hat_jboss_enterprise_application_platform/?
version=6.4。

手順3.3 JBoss EAP インストールプログラムを実行します

1. ターミナルを開き、ダウンロードしたインストールプログラムの JAR を含むディレクトリーに
移動します。

2. 以下のコマンドを入力します。

java -jar jboss-eap-6.x.x-installer.jar

注記
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注記

Hewlett-Packard HP-UX または Solaris 環境では、-d32/-d64 スイッチを使用し
て必要なアーキテクチャーを指定できます。以下のいずれかのコマンドを実行し
てインストーラーを起動します。

java -jar -d64 jboss-eap-6.x.x-installer.jar

または

java -jar -d32 jboss-eap-6.x.x-installer.jar

3. 以下の表の手順を実行します。

表3.1 JBoss EAP インストールプログラム画面

画面の名前 どのような場合に表示さ
れるか

説明

「言語の選択」 Always インストールプログラムに必要な言語を選択し、OK
をクリックします。

「使用許諾契約書」 Always RED HAT JBOSS MIDDLEWARE のエンドユーザー
ライセンス契約。

I accept the terms of this license agreement を選択
し、Next をクリックします。

「インストールパス」 Always JBoss EAP のインストールパスを選択し、Next を
クリックします。新しいディレクトリーを作成する
か、存在する場合は名前付きディレクトリーを置き
換えるように求められます。

「インストールするパッ
クを選択します」

Always インストールするパックを選択します。必要なパッ
クは選択解除のために無効になっています。

「管理ユーザーの作成」 Always 管理ユーザーを作成し、パスワードを割り当てま
す。次へ をクリックします。

「クイックスタートイン
ストール」

Always クイックスタートの例をインストールします。Yes
を選択し、インストールパスを選択します。次へ を
クリックします。

「Maven リポジトリー
のセットアップ」

クイックスタートの例を
インストールすることを
選択した場合

デフォルトの選択を維持して、デフォルトの Maven
設定を自動的に設定し、パブリックにホストされて
いる Maven リポジトリーを使用します。次へ をク
リックします。

「ソケットバインディン
グのセットアップ」

Always デフォルトのポートバインディングを保持し、Next
をクリックします。

「サーバーの起動」 Always インストールプロセスの完了時に、優先するスター
トアップオプションを選択します。次へ をクリック
します。
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「ロギングレベルの設
定」

Always ロギングレベルの設定をスキップするには、No を選
択します。次へ をクリックします。

「ランタイム環境の設
定」

Always Perform default configuration を選択し、Next
をクリックして続行します。

「インストールコンポー
ネントを確認する」

Always 選択内容を確認して、Next をクリックします。

「インストールの進捗」 Always インストールの進行が完了したら、Next をクリック
します。

「インストール処理が完
了しました」

Always 処理が終了したら、Next をクリックします。

「ショートカットを作成
する」

Always デフォルトを受け入れて、Next をクリックします。

「インストールスクリプ
トを生成する」

Always 完了 をクリックします。

インストールが完了しました。

画面の名前 どのような場合に表示さ
れるか

説明

手順3.4 テキストベースのインストールプロセス

1. ターミナルを開き、ダウンロードしたインストールプログラムの JAR を含むディレクトリーに
移動します。

2. 次のコマンドを実行して、テキストベースのインストーラーを起動します。

java -jar jboss-eap-6.x.x-installer.jar -console

3. 手順に従って JBoss EAP 6 をインストールします。

結果

インストールが完了し、JBoss EAP 6 がターゲットマシンにインストールされます。

バグの報告

3.3. ZIP を使用して JBOSS EAP をダウンロードしてインストールする

3.3.1. JBoss EAP 6 のダウンロード (ZIP インストール)

概要

JBoss EAP は、『Red Hat JBoss Developer Program』 または 『Full Red Hat JBoss Commercial
Program』 で利用できます。選択したプログラムに一致する以下の手順に従ってください。

手順3.5 Full Red Hat JBoss Commercial Program のカスタマーポータルから ZIP ファイルをダウン
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手順3.5 Full Red Hat JBoss Commercial Program のカスタマーポータルから ZIP ファイルをダウン
ロードします

Full Red Hat JBoss Commercial Program に参加している場合は、この手順に従ってください。このプ
ログラムの詳細は、「Full Red Hat JBoss Commercial Program について」  を参照してください。

1. ブラウザーを開き、Red Hat カスタマーポータル (https://access.redhat.com) にログインしま
す。

2. Downloads をクリックします。

3. Product Downloads リストの Red Hat JBoss Enterprise Application Platform をクリックし
ます。

4. Version ドロップダウンメニューから正しい JBoss EAP バージョンを選択します。

5. リストから Red Hat JBoss Enterprise Application Platform 6.x.x を見つけ、Download オプ
ションをクリックします。

6. 選択したディレクトリーに ZIP ファイルを保存するように求められます。ディレクトリーを選
択してファイルを保存します。

手順3.6 Red Hat JBoss Developer Program の下で jboss.org から ZIP ファイルをダウンロードします

Red Hat JBoss Developer Program に参加している場合は、この手順に従ってください。このプログラ
ムの詳細は、「Red Hat JBoss Developer Program について」  を参照してください。

1. Web ブラウザーを開き、次の URL にアクセスします。http://www.jboss.org/products/eap/

2. ページの左側にある Download JBoss EAP リンクをクリックします。

3. 正しい製品バージョンについては、Download 列の下にある ZIP リンクをクリックしてくださ
い。

4. 選択したディレクトリーに ZIP ファイルを保存するように求められます。ディレクトリーを選
択してファイルを保存します。

結果

JBoss EAP 6 ZIP ファイルがターゲットマシンに正常にダウンロードされました。

バグの報告

3.3.2. JBoss EAP 6 をインストールします (ZIP インストール)

概要

このトピックでは、ダウンロードした ZIP ファイルを使用して JBoss EAP 6 をインストールする手順に
ついて説明します。

手順3.7 ZIP ファイルのインストール

1. ZIP アーカイブを目的の場所に移動します。
ZIP ファイルを JBoss EAP 6 をインストールする予定のサーバーとディレクトリーに移動しま
す。サーバーを起動および停止するユーザーは、このディレクトリーへの読み取りおよび書き
込みアクセス権を持っている必要があります。
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2. 適切なアプリケーションを使用して、ZIP アーカイブを目的の場所に展開します。
Red Hat Enterprise Linux 環境では、unzip ユーティリティーを使用して ZIP アーカイブのコン
テンツを展開します。

Microsoft Windows 環境では、ファイルを右クリックして Extract All を選択します。

Hewlett-Packard HP-UX 環境では、unzip ユーティリティーを使用して ZIP アーカイブのコン
テンツを展開します。

結果

JBoss EAP 6 の正常なインストールの完了ZIP アーカイブを展開して作成されたディレクトリーは、
サーバーの最上位ディレクトリーです。このディレクトリーを EAP_HOME と呼びます。

バグの報告

3.4. クイックスタートコード例をダウンロードする

3.4.1. クイックスタートのダウンロード

概要

JBoss EAP 6 には、ユーザーが Java EE 6 テクノロジーを使用してアプリケーションの作成を開始でき
るように設計されたクイックスタートコード例の包括的なセットが付属しています。

JBoss EAP のインストール時にクイックスタートの例をインストールすることを選択した場合は、この
トピックをスキップできます。それ以外の場合は、『Red Hat JBoss Developer Program』 または
『Full Red Hat JBoss Commercial Program』 で今すぐダウンロードできます。選択したプログラムに
一致する以下の手順に従ってください。

手順3.8 Full Red Hat JBoss Commercial Program の下でクイックスタートをダウンロードする

Full Red Hat JBoss Commercial Program に参加している場合は、この手順に従ってください。このプ
ログラムの詳細は、「Full Red Hat JBoss Commercial Program について」  を参照してください。

1. ブラウザーを開き、Red Hat カスタマーポータル (https://access.redhat.com) にログインしま
す。

2. Downloads をクリックします。

3. Product Downloads リストの Red Hat JBoss Enterprise Application Platform をクリックし
ます。

4. Version ドロップダウンメニューから正しい JBoss EAP バージョンを選択します。

5. リストの中から Red Hat JBoss Enterprise Application Platform6.x.x Quickstarts を探
し、Download オプションをクリックします。

6. Zip ファイルを選択したディレクトリーに保存するように求められます。ディレクトリーを選択
してファイルを保存します。

7. 選択したディレクトリーでアーカイブを解凍します。

手順3.9 Red Hat JBoss Developer Program で Quickstarts をダウンロードします

Red Hat JBoss Developer Program に参加している場合は、この手順に従ってください。このプログラ
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Red Hat JBoss Developer Program に参加している場合は、この手順に従ってください。このプログラ
ムの詳細は、「Red Hat JBoss Developer Program について」  を参照してください。

1. Web ブラウザーを開き、次の URL にアクセスします。http://www.jboss.org/products/eap/

2. ページの左側にある Download JBoss EAP リンクをクリックして、製品のダウンロード情報
を表示します。

3. Download JBoss EAP で、Quickstarts リンクをクリックして、例を含む Zip アーカイブをダ
ウンロードします。

4. 選択したディレクトリーに ZIP ファイルを保存するように求められます。ディレクトリーを選
択してファイルを保存します。

5. 選択したディレクトリーでアーカイブを解凍します。

バグの報告
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第4章 インストール後の手順

4.1. 開発環境のセットアップ

4.1.1. Red Hat JBoss Developer Studio のインストールの概要

このガイドでは、Red Hat JBoss Developer Studio の最も簡単なインストールパスについて説明しま
す。完全なインストール手順については、『Install Red Hat JBoss Developer Studio』 ガイド
(https://access.redhat.com/documentation/ja-JP/Red_Hat_JBoss_Developer_Studio/) を参照してく
ださい。

バグの報告

4.1.2. Red Hat JBoss Developer Studio のダウンロード

1. https://www.jboss.org/products/devstudio.html にアクセスします。

2. Download ボタンをクリックします。選択したディレクトリーに ZIP ファイルを保存するよう
に求められます。

バグの報告

4.1.3. Install Red Hat JBoss Developer Studio

1. ターミナルを開き、ダウンロードした .jar ファイルを含むディレクトリーに移動します。

2. 次のコマンドを実行して、GUI インストールプログラムを起動します。

java -jar jboss-devstudio-build_version-installer-eap.jar

注記

または、.jar ファイルをダブルクリックしてインストールプログラムを起動でき
る場合もあります。

3. Next をクリックして、インストールプロセスを開始します。

4. I accept the terms of this license agreement を選択し、Next をクリックします。

5. インストールパスを調整し、Next をクリックします。

注記

インストールパスフォルダーが存在しない場合は、プロンプトが表示されま
す。OK をクリックしてフォルダーを作成します。

6. JVM を選択するか、デフォルトの JVM を選択したままにして、Next をクリックします。

7. Red Hat JBoss Developer Studio には、Red Hat JBoss Enterprise Application Platform が含ま
れています。以前にインストールされている場合は、No を選択します。それ以外の場合
は、Yes を選択してインストールし、Red Hat JBoss Developer Studio で使用できるように設
定します。
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8. インストールの詳細を確認し、Next をクリックします。

9. インストールプロセスが完了したら、Next をクリックします。

10. Red Hat JBoss Developer Studio のデスクトップショートカットを設定し、Next をクリックし
ます。

11. 完了 をクリックします。

バグの報告

4.1.4. Red Hat JBoss Developer Studio の起動

Red Hat JBoss Developer Studio を起動するには、インストール中に作成されたデスクトップショート
カットをダブルクリックするか、コマンドラインで起動できます。このトピックでは、コマンドライン
を使用して Red Hat JBoss Developer Studio を起動する方法について説明します。

手順4.1 Red Hat JBoss Developer Studio を起動するコマンド

1. ターミナルを開き、Red Hat JBoss Developer Studio のインストールディレクトリーに移動し
ます。

2. 次のコマンドを実行して、Red Hat JBoss Developer Studio を起動します。

Linux の場合

[localhost]$ ./jbdevstudio

Microsoft Windows の場合

C:\JBDS_INSTALL_DIRECTORY > jbdevstudio.bat

バグの報告

4.1.5. Define New Server を使用して JBossEAP サーバーを追加します

これらの手順は、これが Red Hat JBoss Developer Studio の最初の紹介であり、Red Hat JBoss
Enterprise Application Platform サーバーをまだ追加していないことを前提としています。以下の手順
では、Define New Server ウィザードを使用して、JBoss EAP サーバーを追加します。

手順4.2 サーバーを追加します

1. Servers タブを開きます。Servers タブがない場合は、次のようにパネルに追加します。

a. Window → Show View → Other...をクリックします。

b. Server フォルダーから Servers を選択し、OK をクリックします。

2. 以下をクリックします、No servers are available。このリンクをクリックして、新しいサー
バーを作成します。または、必要に応じて、空白のサーバーパネル内を右クリックし、New →
Server を選択します。

図4.1 新しいサーバーを追加する - No servers available
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図4.1 新しいサーバーを追加する - No servers available

[D]

3. JBoss Enterprise Middleware を展開し、JBoss Enterprise Application Platform 6.1+ を選択
します。JBoss Enterprise Application Platform 6.4 などのサーバー名を入力し、Next をクリッ
クして JBoss ランタイムを作成し、サーバーを定義します。次回新しいサーバーを定義すると
き、このダイアログには、新しいランタイム定義を含む Server runtime environment の選択
が表示されます。

図4.2 新しいサーバーを定義する
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図4.2 新しいサーバーを定義する

[D]

4. サーバーの起動と停止を管理するサーバーアダプターを作成します。デフォルトのままにし
て、Next をクリックします。

図4.3 新しいサーバーアダプターを作成する

第4章 インストール後の手順

17

ld-idm139761676248144.html


図4.3 新しいサーバーアダプターを作成する

[D]

5. JBoss EAP 6.4 Runtime などの名前を入力します。Home Directory で、Browse をクリックし
て、JBoss EAP のインストール場所に移動します。Next をクリックします。

図4.4 新しいサーバーランタイム環境を追加する
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図4.4 新しいサーバーランタイム環境を追加する

[D]

注記

一部のクイックスタートでは、別のプロファイルまたは追加の引数を使用して
サーバーを実行する必要があります。full プロファイルを必要とするクイックス
タートをデプロイするには、新しいサーバーを定義し、Configuration file に 
standalone-full.xml を指定する Server Runtime Environment を追加する必要
があります。新しいサーバーにはわかりやすい名前を付けてください。

6. 新しいサーバー用に既存のプロジェクトを設定します。この時点ではプロジェクトがないた
め、Finish をクリックします。

図4.5 新しい JBoss サーバーのリソースを変更します
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図4.5 新しい JBoss サーバーのリソースを変更します

[D]

結果

JBoss EAP Runtime Server が Servers タブに一覧表示されます。

図4.6 サーバーがサーバーリストに表示されます
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図4.6 サーバーがサーバーリストに表示されます

[D]

バグの報告

4.2. MAVEN を設定する

4.2.1. Maven

Apache Maven は分散型構築自動化ツールで、ソフトウェアプロジェクトの作成、ビルド、および管理
を行うために Java アプリケーション開発で使用されます。Maven は Project Object Model (POM) と呼
ばれる標準の設定ファイルを利用して、プロジェクトの定義や構築プロセスの管理を行います。POM
はモジュールやコンポーネントの依存関係、ビルドの順番、結果となるプロジェクトパッケージングの
ターゲットを記述し、XML ファイルを使用して出力します。こうすることで、プロジェクトが正しく
統一された状態で構築されるようにします。

Maven は、リポジトリーを使用してアーカイブを行います。Maven リポジトリーには Java ライブラ
リー、プラグイン、およびその他のビルドアーティファクトが格納されています。デフォルトのパブ
リックリポジトリーは Maven 2 Central Repository ですが、複数の開発チームの間で共通のアーティ
ファクトを共有する目的で、社内のプライベートおよび内部リポジトリーとすることが可能です。ま
た、サードパーティーのリポジトリーも利用できます。JBoss EAP には、Java EE 開発者が JBoss EAP
でアプリケーションをビルドする際に使用する要件の多くが含まれる Maven リポジトリーが含まれま
す。

Maven に関する詳細は、Welcome to Apache Maven  を参照してください。

Maven リポジトリーに関する詳細は、Apache Maven Project - Introduction to Repositories  を参照して
ください。

JBoss EAP で Maven を使用する方法の詳細は、カスタマーポータルにある Red Hat JBoss Enterprise
Application Platform の 『Development Guide』 の 『Maven Guide』 というタイトルの章を参照して
ください。https://access.redhat.com/documentation/ja-
jp/red_hat_jboss_enterprise_application_platform/?version=6.4。

バグの報告

4.2.2. Maven 設定を設定する

アプリケーションをビルドし、JBoss EAP 6 にデプロイするのに必要なアーティファクトと依存関係は
パブリックリポジトリーでホストされます。アプリケーションをビルドするときにこのリポジトリーを
使用するよう Maven を設定する必要があります。これを行う方法は、Red Hat JBossDeveloperStudio
または Maven コマンドラインを使用してアプリケーションをビルドおよびデプロイする予定があるか
どうかによって異なります。

Red Hat Developer Studio には Maven が含まれるため、個別にダウンロードおよびインストールする
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必要はありません。Red Hat JBoss Developer Studio を使用してアプリケーションをビルドおよびデプ
ロイする場合は、以下の手順を使用して Maven 設定を設定します。 「Red Hat JBoss Developer
Studio で使用するための Maven の設定」

Maven コマンドラインを使用してアプリケーションをビルドおよびデプロイする場合は、最初に次の手
順を使用して Maven をダウンロードしてインストールする必要があります。 「Maven のダウンロード
およびインストール」。次に、以下の手順に従って Maven 設定を設定します。 「コマンドラインで使
用するための Maven の設定」

バグの報告

4.2.3. Maven for Red Hat JBoss Developer Studio の設定

4.2.3.1. Red Hat JBoss Developer Studio で使用するための Maven の設定

アプリケーションをビルドし、Red Hat JBoss Enterprise Application Platform にデプロイするのに必要
なアーティファクトと依存関係は、パブリックリポジトリーでホストされます。アプリケーションをビ
ルドするときにこのリポジトリーを使用するよう Maven を設定する必要があります。このトピックで
は、Red Hat JBoss Developer Studio を使用してアプリケーションをビルドおよびデプロイする場合に
Maven を設定する手順について説明します。

Maven コマンドラインを使用してアプリケーションをビルドおよびデプロイする場合は、このトピック
をスキップできます。代わりに、次の手順に従ってください。 「コマンドラインで使用するための
Maven の設定」 。

Maven は Red Hat Developer Studio で配布されるため、個別にインストールする必要がありません。
ただし、JBoss EAP へのデプロイメントのために Java EE Web Project ウィザードで使用する Maven
を設定する必要があります。以下の手順は、Red Hat JBoss Developer Studio 内から Maven 設定ファ
イルを編集して、JBoss EAP で使用するために Maven を設定する方法を示しています。

手順4.3 Red Hat JBoss Developer Studio で Maven を設定する

1. Window → Preferences の順にクリックし、JBoss Tools を展開して JBoss Maven 
Integration を選択します。

図4.7 Preferences ウィンドウの JBoss Maven 統合ペイン

2. Configure Maven Repositories をクリックします。
3. Add Repository をクリックして、JBoss GA Tech Preview Maven リポジトリー を設定しま
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3. Add Repository をクリックして、JBoss GA Tech Preview Maven リポジトリー を設定しま
す。Add Maven Repository ダイアログで以下の手順を実行します。

a. Profile ID、Repository ID、および Repository Name の値を jboss-ga-repository に設定
します。

b. Repository URL 値を http://maven.repository.redhat.com/techpreview/all に設定しま
す。

c. Active by default チェックボックスをクリックして Maven リポジトリーを有効にします。

d. OK をクリックします。

図4.8 Maven リポジトリーの追加 -JBoss Tech Preview

4. Add Repositoryをクリックして、JBoss Early Access Maven リポジトリーを設定します。Add 
Maven Repository ダイアログで以下の手順を実行します。

a. Profile ID、Repository ID、および Repository Name の値を jboss-earlyaccess-
repository に設定します。

b. Repository URL 値を http://maven.repository.redhat.com/earlyaccess/all/ に設定しま
す。

c. Active by default チェックボックスをクリックして Maven リポジトリーを有効にします。

d. OK をクリックします。

図4.9 Maven リポジトリーの追加 -JBoss Early Access
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図4.9 Maven リポジトリーの追加 -JBoss Early Access

5. リポジトリーを確認して、Finish をクリックします。

図4.10 Maven リポジトリーを確認する
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図4.10 Maven リポジトリーを確認する

6. Are you sure you want to update the file MAVEN_HOME/settings.xml? というメッセージが表示
されます。Yes をクリックして設定を更新します。OK をクリックしてダイアログを閉じま
す。

これで、JBoss EAP Maven リポジトリーが Red Hat JBoss Developer Studio で使用できるよ
うに設定されました。

バグの報告

4.2.4. コマンドライン用に Maven を設定する

4.2.4.1. Maven のダウンロードおよびインストール

Maven コマンドラインを使用して JBoss EAP にアプリケーションをビルドおよびデプロイする場合
は、Maven をダウンロードおよびインストールする必要があります。Red Hat JBoss Developer Studio
を使用してアプリケーションをビルドおよびデプロイする場合は、Maven が Red Hat JBoss Developer
Studio とともに配布されるため、この手順をスキップできます。

1. Apache Maven Project - Download Maven  にアクセスし、ご使用のオペレーティングシステム
に対応する最新のディストリビューションをダウンロードします。

2. ご使用のオペレーシングシステムに Apache Maven をダウンロードおよびインストールする方
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2. ご使用のオペレーシングシステムに Apache Maven をダウンロードおよびインストールする方
法は、Maven のドキュメントを参照してください。

バグの報告

4.2.4.2. コマンドラインで使用するための Maven の設定

アプリケーションをビルドし、JBoss EAP 6 にデプロイするのに必要なアーティファクトと依存関係は
パブリックリポジトリーでホストされます。Red Hat JBoss Developer Studio を使用してアプリケー
ションをビルドおよびデプロイする場合は、このトピックをスキップできます。代わりに、次の手順に
従ってください。「Red Hat JBoss Developer Studio で使用するための Maven の設定」。ただし、
Maven コマンドラインを使用する場合は、Maven 設定を使用してプロジェクト全体で JBoss EAP 6
Maven リポジトリーを使用するように Maven に指示する必要があります。

Maven コマンドラインで使用するための設定方法は 2 つあります。

クイックスタートに付属している事前設定済みの settings.xml ファイルをコピーできます。

Maven の settings.xml ファイルを手動で編集できます。

このトピックでは、両方の方法について説明します。クイックスタートがダウンロードされている場
合、最初の手順が最も簡単な設定方法です。

前提条件

設定する前に、Maven をインストールする必要があります。詳細は、 「Maven のダウンロードおよび
インストール」 を参照してください。

手順4.4 クイックスタートの例に含まれる設定を使って Maven を設定する

Red Hat JBoss Enterprise Application Platform クイックスタートには、オンラインの JBoss EAP
Maven リポジトリーを使用するように設定された settings.xml ファイルが付属しています。クイック
スタートがダウンロードされている場合、この方法が最も簡単な設定方法です。

1. この手順では、既存の Maven 設定ファイルが上書きされるため、既存の Mavensettings.xml
ファイルをバックアップする必要があります。

a. オペレーティングシステムの Maven インストールディレクトリーを見つけます。通
常、USER_HOME/.m2/ ディレクトリーにインストールされます。

Linux または Mac では、これは ~/.m2/ になります。

Windows の場合、これは次のとおりです。\Documents and 
Settings\USER_NAME\.m2\ または \Users\USER_NAME\.m2\

b. 既存の USER_HOME/.m2/settings.xml ファイルがある場合は、後で復元できるように、
ファイルの名前を変更するか、バックアップコピーを作成します。

2. クイックスタートをまだダウンロードしていない場合は、次の手順に従ってください。 「ク
イックスタートのダウンロード」。

3. QUICKSTART_HOME/settings.xml ファイルを USER_HOME/.m2/ ディレクトリーにコピーし
ます。

4. Red Hat JBoss Developer Studio の実行中に settings.xml ファイルを変更する場合は、このト
ピックの最後にある 『Refresh the Red Hat JBoss Developer Studio User Settings』 というタ
イトルトピックの最後にある手順に従ってください。
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手順4.5 Online JBoss EAP Maven リポジトリーを使用するには、Maven 設定を手動で編集および設定
します

JBoss EAP プロファイルを既存の Maven 設定ファイルに手動で追加できます。

1. オペレーティングシステムの Maven インストールディレクトリーを見つけます。通
常、USER_HOME/.m2/ ディレクトリーにインストールされます。

Linux または Mac では、これは ~/.m2/ になります。

Windows の場合、これは \Documents and Settings\USER_NAME\.m2\ または 
\Users\USER_NAME\.m2\ です。

2. settings.xml ファイルが見つからない場合、settings.xml ファイルをUSER_HOME/.m2/conf/
ディレクトリーからUSER_HOME/.m2/ ディレクトリへコピーします。

3. 次の XML を<profiles> ファイルの要素にコピーします。

<!-- Configure the JBoss GA Maven repository -->
<profile>
  <id>jboss-ga-repository</id>
  <repositories>
    <repository>
      <id>jboss-ga-repository</id>
      <url>http://maven.repository.redhat.com/techpreview/all</url>
      <releases>
        <enabled>true</enabled>
      </releases>
      <snapshots>
        <enabled>false</enabled>
      </snapshots>
    </repository>
  </repositories>
  <pluginRepositories>
    <pluginRepository>
      <id>jboss-ga-plugin-repository</id>
      <url>http://maven.repository.redhat.com/techpreview/all</url>
      <releases>
        <enabled>true</enabled>
      </releases>
      <snapshots>
        <enabled>false</enabled>
      </snapshots>
    </pluginRepository>
  </pluginRepositories>
</profile>
<!-- Configure the JBoss Early Access Maven repository -->
<profile>
  <id>jboss-earlyaccess-repository</id>
  <repositories>
    <repository>
      <id>jboss-earlyaccess-repository</id>
      <url>http://maven.repository.redhat.com/earlyaccess/all/</url>
      <releases>
        <enabled>true</enabled>
      </releases>
      <snapshots>
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次の XML をsettings.xml ファイルの要素 <activeProfiles> にコピーします。

4. Red Hat JBoss Developer Studio の実行中に settings.xml ファイルを変更する場合は、このト
ピックの最後にある 『Refresh the Red Hat JBoss Developer Studio User Settings』 というタ
イトルトピックの最後にある手順に従ってください。

手順4.6 Red Hat JBoss Developer Studio のユーザー設定を更新します

Red Hat JBoss Developer Studio の実行中に settings.xml ファイルを変更する場合は、ユーザー設定
を更新する必要があります。

1. メニューから、Window → Preferences を選択します。

2. Preferences ウインドウで Maven を展開表示し、User Settings を選択します。

3. Update Settings ボタンをクリックし、Red Hat JBoss Developer Studio で Maven のユーザー
設定を更新します。

図4.11 Maven ユーザー設定を更新する

        <enabled>false</enabled>
      </snapshots>
    </repository>
  </repositories>
  <pluginRepositories>
    <pluginRepository>
      <id>jboss-earlyaccess-plugin-repository</id>
      <url>http://maven.repository.redhat.com/earlyaccess/all/</url>
      <releases>
        <enabled>true</enabled>
      </releases>
      <snapshots>
        <enabled>false</enabled>
      </snapshots>
    </pluginRepository>
  </pluginRepositories>
</profile>

<activeProfile>jboss-ga-repository</activeProfile>
<activeProfile>jboss-earlyaccess-repository</activeProfile>
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図4.11 Maven ユーザー設定を更新する

[D]

重要

Maven リポジトリーに古いアーティファクトが含まれる場合は、プロジェクトをビルド
またはデプロイしたときに以下のいずれかの Maven エラーメッセージが表示されること
があります。

アーティファクト ARTIFACT_NAME がありません

[ERROR] Failed to execute goal on project PROJECT_NAME; Could not resolve
dependencies for PROJECT_NAME

この問題を解決するには、最新の Maven アーティファクトをダウンロードするために
ローカルリポジトリーのキャッシュバージョンを削除します。キャッシュされたリポジ
トリーは、Linux の場合は ~/.m2/repository/ サブディレクトリー、Windows の場合は 
%SystemDrive%\Users\USERNAME\.m2\repository\ サブディレクトリーにあります。

第4章 インストール後の手順
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第5章 やってみよう

5.1. クイックスタートを実行する

5.1.1. Red Hat JBoss Developer Studio でクイックスタートを実行します

このセクションでは、Red Hat JBoss Developer Studio を使用してクイックスタートをデプロイし、
Arquillian テストを実行する方法について説明します。

手順5.1 クイックスタートを Red Hat JBoss Developer Studio にインポートします

各クイックスタートには、クイックスタートのプロジェクトおよび設定情報を含む POM(プロジェクト
オブジェクトモデル) ファイルが付属しています。この POM ファイルを使用すると、クイックスター
トを Red Hat JBoss Developer Studio に簡単にインポートできます。

重要

Red Hat JBoss Developer Studio へのインポート時にクイックスタートプロジェクト
フォルダーが IDE ワークスペース内にある場合、IDE は無効なプロジェクト名と WAR
アーカイブ名を生成します。作業を開始する前に、クイックスタートプロジェクトフォ
ルダーが IDE ワークスペースの外部にあることを確認してください。

1. まだ行っていない場合は、 「コマンドラインで使用するための Maven の設定」。

2. Red Hat JBoss Developer Studio を起動します。

3. メニューから File → Import を選択します。

4. 選択リストで、Maven → Existing Maven Projects を選択し、Next をクリックします。

図5.1 既存の Maven プロジェクトのインポート

第5章 やってみよう

31



図5.1 既存の Maven プロジェクトのインポート

[D]

5. テストする予定のクイックスタートのディレクトリー (たとえば、helloworld クイックスター
ト) を参照し、OK をクリックします。Projects リストボックスに、選択したクイックスタート
プロジェクトの pom.xml ファイルが示されます。

図5.2 Maven プロジェクトの選択
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図5.2 Maven プロジェクトの選択

[D]

6. Finish をクリックします。

手順5.2 helloworld クイックスタートをビルドしてデプロイする

helloworld クイックスタートは最もシンプルなクイックスタートの 1 つであり、JBoss サーバーが正し
く設定され実行されていることを確認するための良い方法です。

1. Servers タブが表示されない場合、またはサーバーをまだ定義していない場合は、次の手順に
従ってください。「Define New Server を使用して JBossEAP サーバーを追加します」。full
プロファイルまたは追加のスタートアップ引数を必要とするクイックスタートをデプロイする
場合は、クイックスタートの手順に記載されているように、必ずサーバーランタイム環境を作
成してください。

2. Project Explorer タブで jboss-helloworld プロジェクトを右クリックし、Run As を選択しま
す。選択肢のリストが提供されます。Run on Server を選択します。

図5.3 Run As - Run on Server
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図5.3 Run As - Run on Server

[D]

3. サーバーリストから JBoss EAP 6.1+ Runtime Server を選択し、Next をクリックします。

図5.4 Run on Server

[D]

4. 次の画面には、サーバーで設定されているリソースが表示されます。jboss-helloworld クイッ
クスタートが設定されています。Finish をクリックしてクイックスタートをデプロイします。

図5.5 サーバーで設定されたリソースの変更
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図5.5 サーバーで設定されたリソースの変更

[D]

5. 結果を表示します。

Server タブで、JBoss EAP 6.x ランタイムサーバーのステータスが [Started, Republish]
に変わります。

サーバーの Console タブには、JBoss EAP 6.x サーバーの起動と helloworld クイックス
タートのデプロイメントの詳細を示すメッセージが表示されます。

URL (http://localhost:8080/jboss-helloworld/HelloWorld) とテキスト Hello World! を示
す helloworld タブが表示されます。

Console の次のメッセージは、jboss-helloworld.war ファイルのデプロイを確認します。

JBAS018210: Register web context: /jboss-helloworld
JBAS018559: Deployed "jboss-helloworld.war" (runtime-name : "jboss-
helloworld.war")

第5章 やってみよう
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登録された Web コンテキストは http://localhost:8080 に追加され、デプロイされたアプリ
ケーションへのアクセスに使用される URL を提供します。

6. JBoss サーバーに正常にデプロイされた helloworld クイックスタートを確認するには、Web
ブラウザーを開き、次の URL でアプリケーションにアクセスしま
す。http://localhost:8080/jboss-helloworld

手順5.3 bean-validation クイックスタート Arquillian テストの実行

一部のクイックスタートは、ユーザーインターフェイスレイヤーを提供せず、代わりにコード例を示す
ための Arquillian テストを提供します。bean-validation クイックスタートは、Arquillian テストを提供
するクイックスタートの例です。

1. 上記の手順に従って、bean-validation クイックスタートを Red Hat JBoss Developer Studio
にインポートします。

2. Servers タブでサーバーを右クリックし、Start を選択して JBoss EAP サーバーを起動しま
す。Servers タブが表示されない場合、またはサーバーをまだ定義していない場合は、次の手
順に従ってください。「Define New Server を使用して JBossEAP サーバーを追加します」。

3. Project Explorer タブで jboss-bean-validation プロジェクトを右クリックし、Run As を選択
します。選択肢のリストが提供されます。Maven Build を選択します。

4. Edit Configuration ダイアログの Goals 入力フィールドに、次のように入力します clean test -
Parq-jbossas-remote。

次に、Run をクリックします。

図5.6 設定の編集
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図5.6 設定の編集

[D]

5. 結果を表示します。

サーバーの Console タブには、JBoss EAP サーバーの起動と bean-validation クイックスター
ト Arquillian テストの出力の詳細を示すメッセージが表示されます。

-------------------------------------------------------
 T E S T S
-------------------------------------------------------
Running org.jboss.as.quickstarts.bean_validation.test.MemberValidationTest
Tests run: 5, Failures: 0, Errors: 0, Skipped: 0, Time elapsed: 2.189 sec

Results :

Tests run: 5, Failures: 0, Errors: 0, Skipped: 0

第5章 やってみよう
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[INFO] ------------------------------------------------------------------------
[INFO] BUILD SUCCESS
[INFO] ------------------------------------------------------------------------

バグの報告

5.1.2. コマンドラインを使用してクイックスタートを実行する

手順5.4 コマンドラインを使用してクイックスタートをビルドおよびデプロイする

コマンドラインを使用して、クイックスタートを簡単にビルドおよびデプロイできます。コマンドライ
ンを使用する場合、必要に応じて JBoss サーバーを起動する必要があることに注意してください。

1. まだ行っていない場合は、 「コマンドラインで使用するための Maven の設定」 。

2. クイックスタートのルートディレクトリーにある README.html ファイルを確認します。

このファイルには、システム要件、Maven の設定方法、ユーザーの追加方法、およびクイック
スタートの実行方法に関する一般的な情報が含まれています。始める前に必ず読んでくださ
い。

また、利用可能なクイックスタートを一覧表示する表も含まれています。この表には、各ク
イックスタート名とそれが示すテクノロジーがリストされています。各クイックスタートと、
それを設定するために必要な経験のレベルについて簡単に説明します。クイックスタートの詳
細は、クイックスタート名をクリックしてください。

一部のクイック起動は、他のクイック起動を強化または拡張するように設計されています。こ
れらは、Prerequisites の列に記載されています。クイックスタートに前提条件がリストされて
いる場合は、クイックスタートを使用する前にまずそれらをインストールする必要がありま
す。

一部のクイックスタートでは、オプションのコンポーネントのインストールと設定が必要で
す。クイックスタートで必要な場合を除いて、これらのコンポーネントをインストールしない
でください。

3. helloworld クイックスタートを実行します。

helloworld クイックスタートは最もシンプルなクイックスタートの 1 つであり、JBoss サー
バーが正しく設定され実行されていることを確認するための良い方法です。helloworld クイッ
クスタートのルートにある README.html ファイルを開きます。クイックスタートをビルドし
てデプロイし、実行中のアプリケーションにアクセスする方法の詳細な手順が含まれています

4. 他のクイックスタートを実行します。

各クイックスタートのルートフォルダーにある README.html ファイルの指示に従って、例を
実行します。

バグの報告
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付録A インストールプログラムのスクリーンショット

A.1. 言語の選択

図A.1 JBoss EAP インストールプログラムの言語選択
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A.2. 使用許諾契約書

図A.2 JBoss EAP インストールプログラムのエンドユーザー使用許諾契約
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図A.2 JBoss EAP インストールプログラムのエンドユーザー使用許諾契約
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A.3. インストールパス

図A.3 JBoss EAP インストールプログラムのインストールパス
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図A.3 JBoss EAP インストールプログラムのインストールパス
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A.4. インストールするパックを選択します

インストールするパックを選択または選択解除します。必要なパックは選択解除のために無効になって
います。

図A.4 JBoss EAP インストールプログラムをインストールするパックを選択
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図A.4 JBoss EAP インストールプログラムをインストールするパックを選択
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A.5. 管理ユーザーの作成

図A.5 JBoss EAP インストールプログラム管理ユーザーの作成
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図A.5 JBoss EAP インストールプログラム管理ユーザーの作成
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A.6. クイックスタートインストール

図A.6 JBoss EAP インストールプログラムのクイックスタートセットアップ
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図A.6 JBoss EAP インストールプログラムのクイックスタートセットアップ

バグの報告

A.7. MAVEN リポジトリーのセットアップ

図A.7 JBoss EAP インストールプログラム Maven リポジトリーセットアップ
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図A.7 JBoss EAP インストールプログラム Maven リポジトリーセットアップ
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A.8. ソケットバインディングのセットアップ

デフォルトのバインディングを使用するか、カスタムバインディングを設定するかを決定します。ホス
トが IPv6 only に設定されている場合は、Enable pure IPv6 configuration チェックボックスをオンに
します。

図A.8 JBoss EAP インストールプログラムのデフォルトのソケットバインディング
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図A.8 JBoss EAP インストールプログラムのデフォルトのソケットバインディング

バグの報告

A.9. サーバーの起動

図A.9 JBoss EAP インストールプログラムサーバーの起動
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図A.9 JBoss EAP インストールプログラムサーバーの起動

バグの報告

A.10. ロギングレベルの設定

図A.10 JBoss EAP インストールプログラムはロギングレベル設定をスキップする

付録A インストールプログラムのスクリーンショット
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図A.10 JBoss EAP インストールプログラムはロギングレベル設定をスキップする

バグの報告

A.11. ランタイム環境の設定

図A.11 JBoss EAP インストールプログラムランタイム環境の設定 - デフォルト
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図A.11 JBoss EAP インストールプログラムランタイム環境の設定 - デフォルト

バグの報告

A.12. インストールコンポーネントを確認する

図A.12 JBoss EAP インストールプログラムで選択したコンポーネントを確認する
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図A.12 JBoss EAP インストールプログラムで選択したコンポーネントを確認する

バグの報告

A.13. インストールの進捗

図A.13 JBoss EAP インストールプログラムコンポーネントのインストールの進捗
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図A.13 JBoss EAP インストールプログラムコンポーネントのインストールの進捗

バグの報告

A.14. インストール処理が完了しました

図A.14 JBoss EAP インストールプログラムの処理が終了しました
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図A.14 JBoss EAP インストールプログラムの処理が終了しました

バグの報告

A.15. ショートカットを作成する

図A.15 JBoss EAP インストーラーによるショートカットの作成
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図A.15 JBoss EAP インストーラーによるショートカットの作成

バグの報告

A.16. インストールスクリプトを生成する

図A.16 JBoss EAP インストールプログラムはインストールスクリプトを生成します
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図A.16 JBoss EAP インストールプログラムはインストールスクリプトを生成します

バグの報告
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